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Foreword 
This document is a template for Microsoft Word versions ME-XP or later, or Word for Mac OS. 

Authors using Microsoft Word will first need to save the AIAA_Standard.dot file in the “Templates” 
directory of their hard drive. To do so, simply open the AIAA_Standard.dot file and then click “File>Save 
As:” to save the template. (Note: Windows users will need to indicate “Save as Type>Document Template 
(*.dot)” when asked in the dialogue box; Mac users should save the file in the “My Templates” directory.) 
To create a new document using this template, use the command ”File>New>From Template” (Windows) 
or “File>Project Gallery>My Templates” (Mac). The new document that opens will be titled 
“AIAA_Standard.doc.” To create your formatted document, type your own text over sections of 
AIAA_Standard.doc, or cut and paste from another document and then use the available markup styles. 
The pull-down menu is at the left of the Formatting Toolbar at the top of your Word window (for example, 
the style for this portion of the document is “Help”). Highlight a section that you want to designate with a 
certain style, then select the appropriate style name from the pull-down style menu. The style will 
automatically adjust your fonts and line spacing. Do not change the font sizes, line spacing, or margins. 
Use italics for emphasis; do not underline. 

The foreword shall appear in each standard. It shall not contain requirements, figures or tables. 

Prior to the appropriate boilerplate text (see below) give as many of the following as are appropriate: 

— a brief background on the development of the document; 

— an indication of any other organization that has contributed to the preparation of the standard; 

— a statement that the standard cancels and replaces other documents in whole or in part; 

— a statement of significant technical changes from the previous edition of the standard; 

— the relationship of the standard to other standards or other documents; 

— a statement specifying which annexes are normative and which are informative. 

At the time of approval, the members of the AIAA NAME CONSESNSUS BODY were: 

Member Name 1, Chair  Affiliation 

Member Name 2  Affiliation 

The above consensus body approved this document in Month 200X. 

The AIAA Standards Executive Council (VP-Standards Name, Chairman) accepted the document for 
publication in Month 200X. 

The AIAA Standards Procedures dictates that all approved Standards, Recommended Practices, and 
Guides are advisory only. Their use by anyone engaged in industry or trade is entirely voluntary. There is 
no agreement to adhere to any AIAA standards publication and no commitment to conform to or be 
guided by standards reports. In formulating, revising, and approving standards publications, the 
committees on standards will not consider patents that may apply to the subject matter. Prospective users 
of the publications are responsible for protecting themselves against liability for infringement of patents or 
copyright or both. 
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Introduction 
Introduction text goes here 

The introduction is an optional, preliminary element used, if required, to give specific information or 
commentary about the technical content of the standard, and about the reasons prompting its preparation. 
It shall not contain requirements. 

The introduction shall not be numbered unless there is a need to create numbered subdivisions. In this 
case, it shall be numbered 0 with subclauses being numbered 0.1, 0.2, etc. Any numbered figure, table, 
displayed formula or footnote shall be numbered normally beginning with 1. 
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Trademarks 
The following commercial products that require trademark designation are mentioned in this document.  
This information is given for the convenience of users of this document and does not constitute an 
endorsement.  Equivalent products may be used if they can be shown to lead to the same results. 

Trademark 1 

Trademark 2 

The trademarks section is an optional element listing any trademarked products specifically called out in 
the body of the standard.  This section shall not contain requirements.  The content of the section 
shall be prefaced by the boilerplate text above. 
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1 Scope 
Insert Scope text here. 

The Scope clause shall appear at the beginning of each standard and define without ambiguity the 
subject of the standard and the aspect(s) covered, thereby indicating the limits of applicability of the 
standard or particular parts of it. It shall not contain requirements. 

The scope shall be succinct so that it can be used as a summary for bibliographic purposes (i.e., the 
abstract on the first page of the document). 

It shall be worded as a series of statements of fact. Forms of expression such as “This Standard specifies 
[establishes] [gives guidelines for] [defines terms] …” shall be used. 

Statements of applicability of the standard shall be introduced by the wording “This Standard is applicable 
to …”. 

A clause is the basic component in the subdivision of the content of a standard. 

The clauses in each standard or part shall be numbered with arabic numerals, beginning with 1 for the 
“Scope” clause. The numbering shall be continuous up to but excluding any annexes. Numbers given to 
the clauses of an annex shall be preceded by the letter designating that annex followed by a full-stop. The 
numbering shall start afresh with each annex. 

Each clause shall have a title, placed immediately after its number, on a line separate from the text that 
follows it. 

A paragraph is an unnumbered subdivision of a clause or subclause. 

2 Tailoring 
When viewed from the perspective of a specific program or project context, the requirements defined in 
this Standard may be tailored to match the actual requirements of the particular program or project.  
Tailoring of requirements shall be undertaken in consultation with the procuring authority where 
applicable. 

NOTE Tailoring is a process by which individual requirements or specifications, standards, and related documents 
are evaluated and made applicable to a specific program or project by selection, and in some exceptional cases, 
modification and addition of requirements in the standards. 

The Tailoring clause is an optional section included when it is envisioned that requirements contained 
within the standard may need to be tailored to specific projects.  The text above is for guidance only; other 
equivalent text may be substituted if desired and/or appropriate. 

3 Applicable Documents 
The following documents contain provisions which, through reference in this text, constitute provisions of 
this standard. For dated references, subsequent amendments to, or revisions of, any of these publications 
do not apply. However, parties to agreements based on this standard are encouraged to investigate the 
possibility of applying the most recent editions of the normative documents indicated below. For undated 
references, the latest edition of the normative document referred to applies.  

AIA NAS XXX Title 

AIAA S-XXX Title 
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ASTM XXXX Title 

ISO ab-c:199x General title of series of parts — Part c: Title of part 

ISO xyz (all parts) General title of the series of parts 

MIL-STD-XXX Title 

The Applicable Documents clause is an optional element that gives a list of the normative documents to 
which reference is made in the standard in such a way as to make them indispensable for the application 
of the standard. 

In principle, the reference documents shall be currently approved and published consensus documents 
from any appropriate standards developing organization.   

The applicable document list is introduced by the standard wording given above. 

The list shall not include the following: 

— documents that are not publicly available; 

— documents to which only informative reference is made; 

— documents which have merely served as references in the preparation of the standard. 

Such documents may be listed in a bibliography. 

Applicable documents shall be either dated (i.e. to a specific edition) or undated. 

For dated references, each shall be given with its year of publication and full title. Subsequent 
amendments to, or revisions of, dated references will need to be incorporated by amendment of the 
standard referring to them. References to specific divisions or subdivisions, tables and figures of another 
document shall always be dated. 

Undated references may be made only to a complete document or a part thereof and only in the following 
cases: 

a) if it is accepted that it will be possible to use all future changes of the document referred to for the 
purposes of the referring standard; 

b) for informative references. 

Undated references shall be understood to include all amendments to and revisions of the quoted 
publication. The year of publication or dash shall not be given for undated references. When an undated 
reference is to all parts of a standard, the publication number shall be followed by the indication “(all 
parts)” and the general title of the series of parts. 

4 Vocabulary 
4.1 Acronyms and Abbreviated Terms 
AIAA American Institute of Aeronautics and Astronautics 

ASME American Society of Mechanical Engineers 

ASTM American Society of Testing and Materials  
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The Acronyms and Abbreviated Terms section is an optional element giving a list of the acronyms and 
abbreviated terms necessary for the understanding of the standard. 

Unless there is a need to present acronyms in a specific order to reflect technical criteria, all acronyms 
should be listed in alphabetical order in the following sequence: 

— upper case Latin letter followed by lower case Latin letter (A, a, B, b, etc.); 

— letters without indices preceding letters with indices, and with letter indices preceding numerical 
ones (B, b, C, Cm, C2, c, d, dext, dint, d1, etc.); 

— Greek letters following Latin letters (Z, z, Α, α, Β, β … Λ, λ, etc.); 

— any other special acronyms. 

4.2 Terms and Definitions 
For the purposes of this document, the following terms and definitions apply. 

Term 1 
Definition 1 

Term 2 
Definition 2 

The Vocabulary section is an optional element giving definitions necessary for the understanding of 
certain terms used in the standard.  This section should be included ONLY if the terms are unique to that 
particular project and are not found in any other source.  If the AIAA consensus body responsible for the 
document believes there is new terminology in its field that need to be standardized, a separate 
terminology standard should be proposed. 

The term and definition list is introduced by the standard wording noted above. 

When drafting vocabulary definitions, the following concepts should be observed: 

— Any term which is not self-explanatory or commonly known and which can be differently 
interpreted in different contexts shall be clarified by defining the relevant concept; 

— Common dictionary or current technical terms shall be included only if they are used with a 
specific meaning in the relevant context; 

— Definitions in this section shall contain only the text necessary to convey the meaning of the term.  
Extraneous explanatory text should not be included as part of a definition.  Examples and/or 
Notes may be used after definitions to convey ideas essential to the understanding of a definition 
as appropriate. 

— Definitions shall not contain requirements. 

The following examples are included to assist the author of an AIAA Standard document. 
Flight safety system 
combination of flight-, ground-, or space-based hardware and software designed, installed and/or 
operated specifically for providing flight safety 



BSR/ANSI/AIAA S-XXX-200X 

4 

NOTE 1 This combination of equipment, facilities, procedures and personnel required to monitor operations provides 
protection to personnel and property both foreign and domestic from any damage that may be caused by a non-
nominal flight. 

NOTE 2 The flight safety system may include flight termination systems, telemetry data transmitting systems, and 
range tracking systems. 

Flux 
the number of particles passing through a given area in a specified time 

NOTE Flux may also be specified in terms of the number of particles per unit time passing through an area on the 
surface of a sphere enclosed by a solid angle. The units are particles ⋅ cm-2 ⋅ second-1 ⋅ sr-1, where a steradian (sr) is 
defined as the solid angle, which encloses a surface on a sphere equal in area to the radius of the sphere squared. 

Residual stress 
the stress that remains in a structure after processing, fabrication, assembly, testing, or operation 

EXAMPLE A typical example is the welding induced residual stress. 

5 Clause 
5.1 Subclause (level 1) 
5.1.1 Subclause (level 2) 

A paragraph. 

A subclause is a numbered subdivision of a clause. A primary subclause (e.g. 4.1, 4.2, etc.) may be 
subdivided into secondary subclauses (e.g. 4.1.1, 4.1.2, etc.), and this process of subdivision may be 
continued as far as the fourth level (e.g. 4.1.1.1.1, 4.1.1.1.2, etc.). 

Subclauses shall be numbered with Arabic numerals. Numbers given to the subclauses of an annex shall 
be preceded by the letter designating that annex followed by a full-stop. 

A subclause shall not be created unless there is at least one further subclause at the same level. For example, a 
piece of text in clause 10 shall not be designated subclause “10.1” unless there is also a subclause “10.2”. 

Each primary subclause should be given a title, which shall be placed immediately after its number, on a 
line separate from the text that follows it. Secondary subclauses may be treated in the same way. 

5.1.1.1 Subclause (level 3) 

A paragraph. 

5.1.1.1.1 Subclause (level 4) 

A paragraph. 

5.1.1.1.2 Subclause (level 4) 

A paragraph. 

5.1.1.2 Subclause (level 3) 

A paragraph. 

5.1.2 Subclause (level 2) 

A paragraph. 
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Note integrated in the text. 

Notes integrated in the text of a standard shall only be used for giving additional information intended to 
assist the understanding or use of the standard and shall not contain provisions to which it is 
necessary to conform in order to be able to claim compliance with the standard (requirements). 

These elements should preferably be placed at the end of the clause or subclause, or after the paragraph, 
to which they refer. 

A single note in a clause or subclause shall be preceded by “NOTE”, placed at the beginning of the first 
line of the text of the note. When several notes occur within the same clause or subclause, they shall be 
designated “NOTE 1”, “NOTE 2”, “NOTE 3”, etc. 

5.2 Subclause (level 1) 
A paragraph. 

Example integrated in the text. 

Examples integrated in the text of a standard shall only be used for giving additional information intended 
to assist the understanding or use of the standard and shall not contain provisions to which it is 
necessary to conform in order to be able to claim compliance with the standard (requirements). 

These elements should preferably be placed at the end of the clause or subclause, or after the paragraph, 
to which they refer. 

A single example in a clause or subclause shall be preceded by “EXAMPLE”, placed at the beginning of 
the first line of the text of the example. When several examples occur within the same clause or 
subclause, they shall be designated “EXAMPLE 1”, “EXAMPLE 2”, “EXAMPLE 3”, etc. 

Footnotes to the text give additional information; their use shall be kept to a minimum. They shall not 
contain requirements. 

A paragraph with a footnote1) and an ordered list: 

a) first list item at level 1 xxxxxxxxxxxx xxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxxxxxxx xxxxxxxx xxxxxx 
xxxxxxxxxxx xxxxxxxxxxxxxxxxxxxxxx; 

b) second list item at level 1; 

1) first list item at level 2; 

2) second list item at level 2: 

 first list item at level 3; 

 second list item at level 3 xxxxxxxxxxxx xxxxxxxxxxxxxxxxxx xxxxxxxxxxxxxxxxxxxxxxxx 
xxxxxxxx xxxxxx xxxxxxxxxxx xxxxxxxxxxxxxxxxxxxxxx; 

 third list item at level 3. 

Lists may be introduced by a sentence, a complete grammatical proposition followed by a colon, or by 
the first part of a proposition (without a colon), completed by the items in the list. 

Two types of list are commonly used: an ordered list in which each list item is preceded by an item 
reference; an unordered list in which each list item is preceded by a dash. An ordered list shall be used 
                                                
1) A footnote to the text. 
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when it is needed to make reference to individual list items. 

Key terms or phrases may be composed in distinctive type (bold) to call attention to the subject matter 
dealt with in the various list items. Such terms or phrases will not be listed in the table of contents; if it is a 
requirement that they are listed, they shall not be presented as list items but as subclause titles. 

Dimensions in millimeters 

 

PLACE FIGUREa HERE 

 

A paragraph containing a requirement 

NOTE 1 Figure note. 

NOTE 2 Figure note. 

a Figure footnote. 
Figure 1 — Figure title 

Figures should be used wherever appropriate to present information in an easily comprehensible form. It 
shall be possible to refer to each figure explicitly within the text.  Figures shall be cited where applicable.   
Where possible, drawings should be prepared with drawing software that result in JPEG or GIF files.  
Other picture formats that can be converted by Microsoft Word may be acceptable.  Scanned images 
should be used only as a last resort for a standard publication.  Images that are themselves multiple 
generation copies are not acceptable.  AIAA staff shall be responsible for the final determination of a 
figure’s acceptability for publication. 

One level of subdivision only is permitted [e.g. Figure 1 may be subdivided as a), b), c), etc.]. 

Figures shall be numbered with Arabic numerals, beginning with 1. This numbering shall be 
independent of the numbering of the clauses and of any tables. A single figure shall be designated 
“Figure 1”. The numbering shall be continuous up to but excluding any annexes. Numbers given to the 
figures of an annex shall be preceded by the letter designating that annex followed by a full stop. The 
numbering shall start afresh with each annex. 

The title shall be left justified below the figure and laid out as shown in the preceding example. 

Notes to figures shall be treated independently from notes integrated in the text. They shall be located 
above the title of the relevant figure and shall precede figure footnotes . A single note in a figure shall be 
preceded by “NOTE”, placed at the beginning of the first line of the text of the note. When several notes 
occur in the same figure, they shall be designated “NOTE 1”, “NOTE 2”, “NOTE 3”, etc. A separate 
numbering sequence shall be used for each figure. 

Notes to figures shall not contain requirements. Any requirements relating to the content of a figure 
shall be given in the text or as a paragraph between the figure and its title. It is not necessary that notes 
to figures be referred to. 

Footnotes to figures shall be treated independently from footnotes to the text. They shall be located 
immediately above the title of the relevant figure, and shall follow figure notes. 

Footnotes to figures shall be distinguished by superscript lower-case letters, beginning with “a”. The 
footnotes shall be referred to in the figure by inserting the same superscript lower-case letter. 
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Footnotes to figures may not contain requirements.  

Table 1 — Table title 
Column 1 Heading 

(mm) 
Column 2 Heading 

(cm) 
a  

  

  

A paragraph containing a requirement. 

NOTE1 Table note. 

NOTE 2 Table note. 

a Table footnote. 

 
Tables should be used wherever appropriate to present information in an easily comprehensible form. It 
shall be possible to refer to each table explicitly within the text.  Tables shall be cited where applicable. 

A table within a table is not permitted. Subdivision of a table into subsidiary tables is not permitted. 

Tables shall be numbered with Arabic numerals, beginning with 1. This numbering shall be independent 
of the numbering of the clauses and of any figures. A single table shall be designated “Table 1”. The 
numbering shall be continuous up to but excluding any annexes. Numbers given to the tables of an annex 
shall be preceded by the letter designating that annex followed by a full stop. The numbering shall start 
afresh with each annex. 

The title shall be left justified above the table and laid out as shown in the preceding example. 

The heading of each column shall be presented in title case. The units used in a given column shall 
generally be indicated under the column heading as shown above. As an exception to this rule, when all 
units are the same, a suitable statement shall instead be placed above the right-hand corner of the table. 

The column headings together with any statement concerning units shall be repeated on all pages after 
the first. 

Notes to tables shall be treated independently from notes integrated in the text. They shall be located 
within the frame of the relevant table and shall precede table footnotes. A single note in a table shall be 
preceded by “NOTE”, placed at the beginning of the first line of the text of the note. When several notes 
occur in the same table, they shall be designated “NOTE 1”, “NOTE 2”, “NOTE 3”, etc. A separate 
numbering sequence shall be used for each table. 

Notes to tables shall not contain requirements. Any requirements relating to the content of a table shall be 
given in the text, in a footnote to the table or as a paragraph within the table. It is not necessary that notes 
to tables are referred to. 

Footnotes to tables shall be treated independently from footnotes to the text. They shall be located 
within the frame of the relevant table, and shall follow table notes. 

Footnotes to tables shall be distinguished by superscript lower-case letters, beginning with “a”. The 
footnotes shall be referred to in the table by inserting the same superscript lower-case letter. 
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Footnotes to tables may contain requirements. As a consequence, it is particularly important when 
drafting the text of the table footnote to distinguish clearly between different types of provision by using 
the appropriate verbal forms. 

A paragraph. 

 

! 

a

b
= c  (1) 

where 

a is the numerator; 

b is the denominator; 

c is the result of the division. 

Equations between quantities are preferred to equations between numerical values. Equations shall be 
expressed in mathematically correct form, the variables being represented by letter symbols the 
meanings of which are explained in connection with the equations, unless they appear in a “Symbols and 
abbreviated terms” clause. Descriptive terms or names of quantities shall not be arranged in the form of 
an equation. 

If it is necessary to number some or all of the formulae in a standard in order to facilitate cross-reference, 
arabic numbers in parentheses shall be used, beginning with 1. The numbering shall be consecutive and 
independent of the numbering of clauses, tables and figures. 

Numbers given to the formulae of an annex shall be preceded by the letter designating that annex 
followed by a full-stop. The numbering shall start afresh with each annex. 

The International System of units (SI) shall be used when possible.  Other units may be given in 
parenthesis following the SI units. 

The units in which any values are expressed shall be indicated. 

For clarity, the symbol × rather than a point shall be used to indicate multiplication of numbers and 
numerical values. 

If a value less than 1 is written in decimal form, the decimal sign shall be preceded by a zero. 
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Annex A Annex Title (Informative) 
A.1 General 
Annexes shall appear in the order in which they are cited in the text. Each annex shall be designated by 
a heading comprising the word “Annex” followed by a capital letter designating its serial order, beginning 
with “A”, e.g. “Annex A”. The annex heading shall be followed by the title and the indication “(normative)” 
or “(informative)” all on a single line. Numbers given to the clauses, subclauses, tables, figures and 
mathematical formulae of an annex shall be preceded by the letter designating that annex followed by a 
full-stop. The numbering shall start afresh with each annex. A single annex shall be designated 
“Annex A”. 

Normative annexes are integral parts of the standard. Their presence is optional. An annex’s normative 
status (as opposed to informative) shall be made clear by the way in which it is referred to in the text, by a 
statement to this effect in the foreword and by an indication in the table of contents and under the heading 
of the annex. 

Informative annexes give additional information intended to assist the understanding or use of the 
standard and shall not contain provisions to which it is necessary to conform in order to be able to claim 
compliance with the standard (requirements). Their presence is optional. An annex’s informative status 
(as opposed to normative) shall be made clear by the way in which it is referred to in the text, by a 
statement to this effect in the foreword and by an indication in the table of contents and under the heading 
of the annex. 

A.2 Clause 
A.2.1 Subclause (level 1) 

A.2.1.1 Subclause (level 2) 

Text 

A.2.1.2 Subclause (level 2) 

Text 

A.2.2 Sublcause (level 1) 

Text 


